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PRECAUTIONS AND SAFETY

Preface

Precautions and Safety

Before you handle any equipment you must comply with the safety advices.

Adherence to the safety instructions ensures compliance with the safety requirements as
defined in IEC 62368-1 (Audio/video, information and communication technology equipment -
Part 1: Safety requirements).

Please refer to the following document:
[1TKHW002497] Operating Instruction “Precautions and safety”.

Symbols and Notations

This Application Note uses the following symbols:

NOTICE Non-observance could result in equipment damage.
Failing to comply with this may result in physical damage of equipment.
— Possible actions are given.

Risk of operating trouble!
Indicates that an action may lead to operating trouble or loss of data.
— Possible actions are given.

|I| Please note:
Shows significant information.

— Possible actions are given.

Target Audience

This Application Note is targeted at persons who are entrusted with the operation and adminis-
tration of the system.

The persons targeted are
» the operation and administration personnel.

|I| Please note:
Only instructed or skilled persons as per IEC 62368-1 may install and maintain the
system.

Terms and Abbreviations

Table 1: Terms and abbreviations
Term Meaning Explanation
Core Unit Designates the core and control unit CESM1, CESM1-

F, CESM2, CESM2-F, CESM4, CESM4-F, CESM4EF,
CESM4E, or CESM3 of FOX61x.

Where certain features or characteristics apply to a spe-
cific core unit only, the CESM1, CESM1-F, CESM2,
CESM2-F, CESM4, CESM4-F, CESM4EF, CESM4E, or
CESM3 is named explicitly.
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PREFACE
TERMS AND ABBREVIATIONS

Table 1: Terms and abbreviations (continued)

Term Meaning Explanation

ESW Embedded Software Software that is running on a specific HW unit of the
FOX61x.

FO Foreign Object Any third-party object that can be modeled with sections
and termination points included in a managed network.

GUI Graphical User Interface

HW Hardware

ID Identifier

DIRAC Centralized management system for the SENC1 units,
responsible for the generation and distribution of the
Master Keys.

FOXCST FOX61x Configuration Soft- Network element manager for FOX61x network ele-

ware Tool ments.

ENP Ethernet Networking Package A part of the FOXMAN-UN, used for the configuration,
provisioning, and monitoring of MPLS-TP services.

ESM Ethernet Security Manager A part of the FOXMAN-UN, user interface for setting up
security related network functions such as encrypted
transmission.

NE Network Element A network node, e.g. a FOX615.

NEM Network Element Manager A network element manager, e.g. FOXMAN-UN

NP Networking Package A specific package included in FOXMAN-UN for manag-
ing TDM networks.

RHEL Red Hat Enterprise Linux Red Hat Enterprise Linux operating system

FOXMAN-UN Universal Network Manager  Hitachi Energy Network Manager software for FOX61x
network elements.

VM Virtual Machine

Copyright 2025 Hitachi Energy. All rights reserved.
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SUPPORTED UPGRADE SCENARIO

Purpose and Scope

This Application Note describes the procedure for upgrading specific versions of the FOXMAN-
UN network manager and of the FOX61x network elements.

The Application Note includes a description of the prerequisites, the steps to be executed, and
the expected result of the upgrade.

Supported Upgrade Scenario

FOXMAN-UN Upgrade

This Application Note describes the procedures for
« upgrading the FOXMAN-UN network manager
- from system release R17A to system release R18,
- from system release R16B to system release R18.
Basically the following upgrades are supported within the scope of this Application Note:

Upgrade to R18  Details Uninstall and reinstall required?
from version...

R17A OS upgrade to RHEL 9.6 required. - Create backup of NEM database,
R16B OS upgrade to RHEL 9.6 required. - Uninstall old version,

upgrade OS,
install new version,
restore backup from old version.

For more information see
» section 3.1 FOXMAN-UN and DIRAC upgrade (on page 14) for the R17A to R18 upgrade, or
+ section 4.1 FOXMAN-UN and DIRAC upgrade (on page 24) for the R16B to R18 upgrade.

Foreign Object (FO) Upgrade

If your managed network includes Foreign Objects (FO), every FO from a release R16A or older
will need to go through a migration procedure after upgrading FOXMAN-UN. For details see
section 3.1.2 Upgrade FOXMAN-UN database from R17A to R18 (on page 15) or section 4.1.2
Upgrade FOXMAN-UN database from R16B to R18 (on page 25), and section 5 Foreign Object
(FO) Upgrade to R18 (on page 35).

FOX61x Upgrade

This Application Note describes the procedures for
» upgrading the FOX615, FOX612, FOX611 and/or FOX610 network elements
- from system release R17A to system release R18,
- from system release R16B to system release R18,
using the FOXMAN-UN network management system, see section 3.2.2 Upgrade via FOX-
MAN-UN (ESW Distribution Wizard) (on page 17) or section 4.2.2 Upgrade via FOXMAN-UN
(on page 27).
» upgrading the FOX615, FOX612, FOX611 and/or FOX610 network elements
- from system release R17A to system release R18,
- from system release R16B to system release R18,

using the standalone version of the FOXCST element manager, see section 3.2.3 Upgrade
via FOXCST (on page 18) or section 4.2.3 Upgrade via FOXCST (on page 28).
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SUPPORTED UPGRADE SCENARIO

The FOX61x system release determines the type and ESW version of the core unit(s) and the
related set of service units that can be operated with the core unit(s). The version details of the
ESW for each system release can be found in the respective system release notes, and in sec-
tion 2.3 Version Information (on page 11).

|I| Please note:
If weak or empty passwords have been used for accessing NEs (because that was
possible in previous releases), this shall be changed with the present release. For
a guidance on appropriate password policies read and follow the sections “Pass-
word Rules for Local Authentication” and “Strong Password Policy” in
[1TKHW028522] User Manual “Management Communication” (FOX61x R18).

214 Upgrade Sequences

The FOXMAN-UN and FOX61x upgrade procedure requires to strictly follow the correct
sequence of upgrading steps.

ﬂ NOTICE Non-observance could result in equipment damage.

Upgrading Embedded Software of FOX61x network elements from ESW released
prior to R18 to ESW released with R18 before having upgraded FOXMAN-UN to
R18 may result in incompatibility of FOXMAN-UN and FOX61x network elements
software and cause unpredictable behavior.

— Always upgrade FOXMAN-UN to R18 before upgrading any ESW of FOX61x
network elements to R18.

Risk of operating trouble!
Do not change any configuration of the FOX61x network elements during the net-

work upgrade process.
— The changes could be lost.

Please note:

S FOXMAN-UN (including add-ons) of system release R18 require a RHEL 9.6 oper-
ating system.

Please note:
[ | FOXMAN-UN R18 includes a new DIRAC version (18.0.0) vs. the one previously
released with FOXMAN-UN R17A.

— The DIRAC database of a previous R16B or R17A installation is compatible with
the new R18 RHEL 9.6 server.

|I| Please note:
Prior to the start of the upgrade procedure, it is strongly recommended to save the
latest used NE configurations on the NE, then create a backup of every NE config-
uration by saving the NE configurations to disk.

Copyright 2025 Hitachi Energy. All rights reserved. 7
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SUPPORTED UPGRADE SCENARIO

2.1.41 Network Upgrade Sequence without MPLS-TP Encryption

The Figure 1 shows the upgrade sequence for FOXMAN-UN and FOX61x to system release
R18 when no MPLS-TP encryption is used in the network, i.e., if no DIRAC and SENC1 units
are used in your network.

For the detailed upgrade procedure see section 3 Upgrade R17A to R18 (on page 14) and sec-
tion 4 Upgrade R16B to R18 (on page 24).

Start upgrade of FOXMAN-UN and FOX61x to
system release R18

'

Set up server with RHEL 9.6

h J

Backup from old Install FOXMAN-UN
FOXMAN-UN installation

FOXMAN-UN
database

¥

Restore database from old installation

L 4

Upgrade FOX61x network elements

L J
Upgrade of FOXMAN-UN and FOX61x to
system release R18 completed

Figure 1: Upgrade sequence without MPLS-TP encryption

Copyright 2025 Hitachi Energy. All rights reserved. 8
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SUPPORTED UPGRADE SCENARIO

2.1.4.2 Network Upgrade Sequence with MPLS-TP Encryption

The Figure 2 shows the upgrade sequence for FOXMAN-UN and FOX61x to system release

R18 when MPLS-TP encryption is used in the network, i.e., if you have installed DIRAC and if
you are using SENC1 units in your network.

For the procedures to upgrade from R17A or R16B to R18 see details in section 3 Upgrade
R17A to R18 (on page 14) and section 4 Upgrade R16B to R18 (on page 24).

(Start upgrade of FOXMAN-UN and FOX61x )

to system release R18

L J

Set up server with RHEL 9.6

h J

Install FOXMAN-UN

¥

Backup from old Install DIRAC
FOXMAN-UN installation

FOXMAN-UN
database

L J

Restore database from old installation

Y

Upgrade FOX61x network elements

¥

Upgrade SENC1 units
Upgrade of FOXMAN-UN and FOX61x to
system release R18 completed

Figure 2: Upgrade sequence with MPLS-TP encryption

Copyright 2025 Hitachi Energy. All rights reserved.
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SUPPORTED UPGRADE SCENARIO

Network Upgrade Sequence without Network Manager

A FOX61x network managed only by the element manager FOXCST requires no FOXMAN-UN
and no DIRAC applications, provided no encryption is applied to the MPLS-TP tunnels. The Fig-
ure 3 shows the upgrade sequence for FOX61x to system release R18.

For the detailed procedure of the R17A to R18 upgrade see 3.2.3 "Upgrade via FOXCST". For
the detailed procedure of the R16B to R18 upgrade see 4.2.3 "Upgrade via FOXCST".

Start upgrade of FOX61x to system
release R18

v

Upgrade FOX61x network elements

v

Upgrade of FOX61x to system release
R18 completed

Figure 3: Upgrade sequence without network manager

Workaround for FOXMAN-UN Upgrade in Main/Standby Setup

This chapter describes a workaround for the limitation “Unable to pair servers after reinstallation
without unpairing” described in the list of limitations provided with the FOXMAN-UN R18 release
note.

Initial situation: Main server and Standby server are paired.

To upgrade the Standby server, the previous FOXMAN-UN version on the Standby server is
uninstalled, and the FOXMAN-UN 18.0.0 is installed on the Standby server.

Also, Main/Standby functionality on the Standby server, i.e., periodic backup and configuration
as cold or warm standby, is re-enabled. The described limitation describes the fact that while
uninstalling, the existing pairing is broken.

Now when you connect to the Main server using the Remote Admin Tool (RAT), to configure the
Partner server (i.e., the Standby server), you get an error message (“Communication to the
remote server is broken”), and the RAT is closed.

To prevent this:

1. Open the RAT again but do not click on “Configure Partner Server...”, but click on “Main/
Standby Configuration...”.

2. Acknowledge the error message.

3. In the Main/Standby Settings, select the Partner Server that is still configured by clicking on
the respective table entry.

4. Click the “Unpair” command button and acknowledge the confirmation message.
» Click on “Cancel”.

5. Back in the RAT main window, click on “Main/Standby Configuration...” again.

6. In the Main/Standby Settings, click the “Pair...” command button.

* Log in to the remote (Standby) server by entering username, password, and host name
and/or IP address, then click the “Pair” button.

7. Accept the SSL Certificate, then acknowledge the confirmation of successful pairing.
8. Click OK to conclude the Main/Standby settings.

Result: Servers are successfully paired again.

Copyright 2025 Hitachi Energy. All rights reserved. 10
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2.2

2.21

2.2.2

2.3

UNSUPPORTED UPGRADE SCENARIOS

Unsupported Upgrade Scenarios

FOXMAN-UN Upgrade

FOXMAN-UN network managers with a system release older than R16B must first be upgraded
to one of the upgradeable system releases as listed in section 2.1 Supported Upgrade Scenario
(on page 6) before upgrading to system release R18. Please refer to the corresponding upgrade
Application Note of an earlier system release.

FOX61x Upgrade

For any upgrades of FOX61x network elements running on ESW from a system release older
than R16B refer to the upgrade application note included in the respective system release docu-
mentation for intermediate upgrades.

For the case of ERPS applications in system release R1D SP04, see separate document
[1KHW029183-FR17A] Application Note “Upgrade ERPS from R1D to R17A”.

NOTICE Non-observance could result in equipment damage.

Upgrading Embedded Software of FOX61x network elements from ESW released
prior to R14A to ESW released with R18 may result in non-operational units.

— FOX61x network elements running on ESW from any system release older than
R14A must first be upgraded to the system release R14A before upgrading to
newer system releases. Please refer to the corresponding upgrade Engineering
Bulletins or Application Notes.

Upgrades from FOX61x configurations running on HW and/or ESW other than shown in Table
2: "Upgradeable Units and ESW with System Release R17A" (on page 19) or Table 3:
"Upgradeable Units and ESW with System Release R16B" (on page 29) are not described in
this Application Note.

If you have ESW running on your units that is different from the ESW types and versions listed
in Table 2 or Table 3, please contact Hitachi Energy technical support (see section 6.2 Techni-
cal Support (on page 36)).

Version Information

With regard to system release R16B and/or R17A, the system release R18 provides new ESW
files for the following core units:

+ CESM1, CESM1-F,

+ CESM2, CESM2-F,

+ CESMS,

and for the following service units:

+ BIGO1,

+ ELET1,

+ EPEX1,

+ EROP1, EROP1-F,

+ ETOP1, ETOP1-F,

+ ESPO1 (ESW running on EPOI1 HW),

+ ESOP1, ESOP1-F (ESW running on ETOP1, ETOP1-F HW),
+ EPON,

+ DEFM1, DEFM1-F,

+ SAMO2, SAMO2-F, SAMO3, SAMO5, SAMOS5-F,
« TEPI2,

Copyright 2025 Hitachi Energy. All rights reserved. 11
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VERSION INFORMATION

. ODIS1 (R1, R2 HW),

« OPICY,

.« OPIC2 (R1, R2 HW),

« TEGO1,

+ SENC1-4, SENC1F4, SENC1-8, SENC1F8,

« CEPI1 (R3 HW),

* LEDE1 (R2 HW),

« LEDS1 (R1, R2 HW).

Any release can potentially include hotfixes for these or other units.

]

]

Please note:

Before upgrading, make sure to have access to the latest versions (including hot-
fixes where available) for each ESW released with the target FOX61x system
release R18. Hotfixes are either provided by Hitachi Energy technical support or
are available for download on the Hitachi Energy Publisher (https://pub-
lisher.hitachienergy.com).

Please note:

An ESW running on a unit can be a regular ESW, a hotfix ESW, a test ESW, or a
customer specific ESW.

— The ESW names are composed correspondingly:

regular ESW: <name>_rnxnn (e.g. samo1_r3d01),

hot fix ESW: <pname>_rnxnn_nn (e.g. samo1_r3d01_02),
test ESW: <name>_rnxnn_tnn (e.g. samo1_r3d01_t01),
customer specific ESW: <name>_rnxnn_cnn (e.g. samo1_r3d01_c01),
where:

<name> stands for the ESW name in small letters and digits,
r stands for “release”,

n stands for a digit 1...9,

x stands for a letter a...z,

nn stands for two digits 01 ... 99,

t stands for “test version”,

c stands for “customer specific version”.

Any test ESW or customer specific ESW running on a unit that is to be upgraded may present
an increased risk for encountering problems during the upgrade procedure. Also there is no
warranty that test features or customer specific features built into one of these ESWs will still be
present after the upgrade to regular system release ESW unless implementation has been con-
firmed by Hitachi Energy.

Some of the ESW files that are listed as part of a system release may have been released with
an earlier system release but are still compatible, and are therefore no impediment to an

upgrade.

]

Please note:

When upgrading to R18, the upgrade procedure described in this Application Note

is exclusively applicable to the FOX61x units listed in the “Unit name” column of

Table 2 or Table 3.

— Units that are not listed in one of these tables are not upgradeable with the pro-
cedure described in this Application Note.

Copyright 2025 Hitachi Energy. All rights reserved. 12
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24 Background Information

Risk of system crash!

If an upgrade is done while operating units with a HW or ESW that does not match
the state or version given in this Application Note, the FOX61x may get into an
operation state that doesn’t allow to provide services as expected.

Also in case of complying with the HW and the ESW versions given in this Applica-
tion Note there is a small risk of getting the FOX61x into an operation state that
doesn’t allow to provide services as expected after the upgrade.

— In such a case you should restore the previous configuration and contact Hita-
chi Energy technical support (see section 6.2 Technical Support (on page 36)).

— Make sure that you save the NE configuration and create a backup file before
proceeding to the upgrade procedure via the FOXCST menu function “File >
Save Configuration to Disk ...” or “File > Save Configuration to Disk As ...".
Save the NE configuration as .tar file.

Copyright 2025 Hitachi Energy. All rights reserved. 13
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3.1

3141

FOXMAN-UN AND DIRAC UPGRADE

Upgrade R17A to R18

]

Please note:

FOXMAN-UN and DIRAC of system release R18 require a RHEL 9.6 operating
system. It is recommended to prepare a new separate RHEL 9.6 server or VM for
FOXMAN-UN R18. The old RHEL server machine or VM, used by the FOXMAN-
UN before system release R18, can be switched off once the system upgrade is
successfully completed.

Be aware that if you want to be able to use the FOXMAN-UN R17A and R18 clients
on Windows at the same time, they need to be installed on separate machines.
Also refer to the FOXMAN-UN R18 release note for more details on the upgrade
procedure.

If you do not have a new server HW or VM available, upgrade via the basic steps:

+ Create database backup on installation prior to upgrade and save it to a secure
folder.

* Uninstall current FOXMAN-UN R17A.

+ Upgrade RHEL OS to version 9.6.

» Install FOXMAN-UN R18 core and add-ons as required. Install R18 client(s).
* Restore database backup from old installation to the new R18 installation.

» Start NEM services (nemstart), then log in from client.

+ Recommended: Execute a force poll of each managed node.

» Make sure to still follow the steps listed below (except the one to provide a new
server or VM).

FOXMAN-UN and DIRAC upgrade

FOXMAN-UN R18 Installation on RHEL 9.6 Server

Follow the steps below to install the FOXMAN-UN and DIRAC of system release R18 on a
RHEL 9.6 server:

1 Install RHEL 9.6 on an appropriate server or VM.
2 Install FOXMAN-UN R18 on the RHEL 9.6 server.

Apply the FOXMAN-UN R18 license on the RHEL 9.6 server. If you are using MPLS-TP tun-
nel encryption with SENC1 units and DIRAC, the license must include the DIRAC feature.

3 Install R18 NEM_ADDONS as required.

]

While coming from R17A, do also install DIRAC if you are using the ESM (Ethernet
Security Manager) feature.

Please note:

The new R18 RHEL 9.6 server will most likely have a different IP address than the
old RHEL server used by the FOXMAN-UN before system release R18. Therefore
agent IP addresses need to be adjusted accordingly.

This can be done manually once the database is restored and services are run-
ning.

Another option is to setup a “/opt/nem/etc/iptranslate.cont” file and use
the “-a” key during the database restore:

edbrestore -b <database name> -a.

— In this way, the agent IP addresses will be automatically adjusted according to
the information in the “iptranslate.conf” file.

Copyright 2025 Hitachi Energy. All rights reserved. 14
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3.1.2

FOXMAN-UN AND DIRAC UPGRADE

Upgrade FOXMAN-UN database from R17A to R18

For an upgrade from R17A to R18, the procedure is considering that the DIRAC database must
be upgraded from R17A to R18. Follow the steps below:

1

Perform a force poll on all network elements on your existing (old) FOXMAN-UN server.
The network should be as stable and alarm free as possible. Take note of the following:
- Any present alarms and unmanaged network element.

- Anything in invalid state on NP, ESM or ENP.

Create a backup of the NEM database on your existing (old) FOXMAN-UN server.

Create a backup of the following files from the folder “/opt/nem/etc” on your existing (old)
FOXMAN-UN server:

/opt/nem/etc/iptranslate.conf
/opt/nem/etc/firewall.conf

Create a backup of the following files if they are present:
/opt/nem/etc/cst1_license.xml
/opt/nem/etc/npfotool_crossconnect.csv
/opt/nem/etc/npfotool_termination.csv
/opt/nem/etc/npfotool_trailhierarchy.csv

Restore the backed-up files from /opt/nem/etc on the new FOXMAN-UN R18 RHEL 9.6
server.

Restore the backed-up NEM database on the new FOXMAN-UN R18 RHEL 9.6 server.

Some general information on the database upgrade is given in [1KHWO002414] User Manual
“FOXMAN-UN under Linux”.

Start FOXMAN-UN services by executing nemstart.

|I| Please note:
In networks with 1000 or more NEs, the initialization of the NMS system can take

between 20 and 30 minutes. The system is not fully operational during this time.

7 Once the FOXMAN-UN services are running, log in to FOXMAN-UN and check the NEM

Browser, Networking Package (NP), Ethernet Security Manager (ESM) and Ethernet Net-
working Package (ENP). Refer to the following table for the status:

Item Status

NEM Browser  All network elements are manageable and are alarm free.!

NP The status matches the one on the server of the previous release.

ESM All Crypto Engines have the Communication Status “Manageable”. Note that it may
take some time until this status is shown.

ESM The port mappings are present.

ENP All encrypted tunnels have the Encryption Status “Valid” and the Status “Deployed
Valid”.

ENP VPLS, VPWS, Pseudo Wire, Link, NE and Service Profile are in the same state as

on the server of the previous release. Some services may be “Unaligned”.

1. On a customer network there might be alarms or unmanageable network elements present before the
upgrade. The alarm and network element situation on the new R18 server should match the situation
on the server of the previous release.

All network elements still run the ESW of the old system release (R17A) but are now man-
aged by FOXMAN-UN R18.

MPLS Service migration: MPLS services without control word (if there are any) must be
migrated to services with control word. Control word shall be migrated before upgrading the
nodes, else there is a risk to lose packets due to time stamping non PTP packets on SENC1
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or EPEX1 units. It is recommended to do this step even if you currently do not operate
SENC1 or EPEX1 units.

Therefore, execute the script “Set PW Control Word” from the FOXMAN-UN - R18 “NEM
Desktop - System - Remote Executor...”. Execute the script service by service, node by node
or network-wide, as preferred.

9 Upgrade FOX61x network elements ESW to R18. For details see section 3.2.2 Upgrade via
FOXMAN-UN (ESW Distribution Wizard) (on page 17).

10 If any services appear invalid or unaligned after the NE ESW upgrade has been successfully
terminated, execute the steps in section 3.1.3 "Post-upgrade steps".

11 If your setup includes Foreign Objects (FO), follow the instructions given in section 5 Foreign
Object (FO) Upgrade to R18 (on page 35).
12 Once the new system is stable, disconnect or uninstall the old FOXMAN-UN.

Post-upgrade steps

If you are using Service Supervision and you have VPWS system services with service supervi-
sion enabled,

Proceed as follows:

1. Disable service supervision for all such VPWS system services. This can be done from the
ENP GUI, VPWS tab.

*  Wait until all VPWS are removed from the Service Supervisor.

2. Execute a “Clear and Synchronize” from the ENP menu option “Network - Clear and Syn-
chronize”.

» This menu option requires Expert Mode to be active. To activate it, select “Options -
Expert Mode” from the ENP menu.

3. Enable service supervision for all previous VPWS system services. This can be done from
the ENP GUI, VPWS tab.

»  Wait until all VPWS are listed again in the Service Supervisor.
End of instruction

In certain cases, some MPLS-TP services may appear as “Deployed Invalid” in ENP after the
database has been restored and the FOXMAN-UN services are started. This may be the case
e.g. if modifications to the MPLS-TP configuration made with FOXCST have not been loaded to
the FOXMAN-UN database. The following steps will resolve this.

Proceed as follows:

1 Execute a force poll on all nodes.

2 Check the services status again in ENP.

3 If there are still services with status “Deployed Invalid”, execute a “Clear and Synchronize” in
ENP by selecting the menu option “Network - Clear and Synchronize”. This menu option
requires Expert Mode to be active. To activate it, select “Options - Expert Mode” from the
ENP menu.

“Clear and Synchronize” will clear the services from the database and load them again from
all nodes in the network. Wait until this has been terminated. The services should now all
have “Deployed Valid” status.

4 Align all ENP services (VPLS and VPWS) from the ENP main window that are not aligned.
End of instruction

In case VPWS services are added to service supervision, VPWS services from previous
releases that are using PWAC ports are missing those PWAC ports in the service supervision.
VPWS modeling in Service Supervision was missing the PWAC ports. This is now fixed in R18.

To update the existing VPWS supervision from previous releases with the PWAC ports,
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Proceed as follows:

1. Execute the command “Reload Configuration” from the service context menu in the ENP leg-
acy application for the affected VPWS services. This will add the missing PWAC ports to the
Service Supervision model of the VPWS services.

End of instruction

FOX61x upgrade

This section describes the FOX61x nodes upgrade.

Pre-upgrade steps

Before starting the node upgrade, perform the following steps:

1 MPLS Service migration: MPLS services without control word (if there are any) must be
migrated to services with control word. Control word shall be migrated before upgrading the
nodes, else there is a risk to lose packets due to time stamping non PTP packets on SENC1
or EPEX1 units. It is recommended to do this step even if you currently do not operate
SENC1 or EPEX1 units.

Therefore, execute the script “Set PW Control Word” from the FOXMAN-UN - R18 “NEM
Desktop - System - Remote Executor...”. Execute the script service by service, node by node
or network-wide, as preferred.

Risk of operating trouble!
After upgrading to R18, packets without PW control word may get time stamped
even they are not PTP packets, this may result in packet loss.

Risk of operating trouble!
Make sure that ENP services are in valid state before starting the service migration

with the Remote Executor tool.

2 Make sure that gateway address for static routes and for default routes are not identical to
the IP address of the local management interface, else you may risk to lose connectivity to
the network. If the addresses are identical, reconfigure them before starting the upgrade pro-
cedure.

Upgrade via FOXMAN-UN (ESW Distribution Wizard)

ﬂ NOTICE Non-observance could result in equipment damage.

Upgrading Embedded Software of FOX61x network elements from ESW released
prior to R18 to ESW released with R18 before having upgraded FOXMAN-UN to
R18 may result in incompatibility of FOXMAN-UN and FOX61x network elements
software and cause unpredictable behavior.

— Always upgrade FOXMAN-UN to R18 before upgrading any ESW of FOX61x
network elements to R18.

ﬂ NOTICE Non-observance could result in equipment damage.

Upgrading Embedded Software of FOX61x network elements from ESW released
prior to R14A to ESW released with R18 may result in non-operational units.

— FOX61x network elements running on ESW from any system release other than
R14A must first be upgraded to the system release R14A before further upgrad-
ing. Please refer to the corresponding upgrade Engineering Bulletin or Applica-
tion Note.
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Follow the steps in the FOXMAN-UN ESW Distribution Wizard recommended below to upgrade
the FOX61x network elements to system release R18 (including SENC1 units):

1 Select “Network - ESW Management - Distribution Wizard” from the NEM Desktop menu to
create an ESW distribution job; give the job an appropriate name. Click “Next >”.

2 Mark “Download ESW on all Units”, “Delete oldest unassigned ESW before”, “Start ESW on
all Units”; if you are using equipment protection, do not mark “Minimal Service Interruption -
Revertive EQP” or “Minimal Service Interruption - Non-Revertive EQP”, but mark “System
Release Upgrade”. Optionally mark “Abort on first Error”. Click “Next >”.

3 Import R18 ESW ZIP archive via the “Import ESW...” button, then select “R18” in the
“Desired System Release” drop-down box. Select all applicable ESW from the “Select ESW”
list. Make sure the correct ESW version is selected for each unit. Click “Next >”.

4 Select the NEs to be upgraded. Click “Next >".

5 Expand all NEs. Verify “Current ESW Version” and “ESW to Install” for each NE and unit.
When OK, click “Next >".

6 Set the processing order of NEs in accordance with network specific requirements. Click
“Next >”.

7 If required, rearrange the NEs in groups. When OK, click “Next >”.

8 Set the schedule actions as required. When OK, click “Next >”.

9 Mark “Launch the ‘Task Viewer’ upon <Activate>", then click “Activate” to activate the job
and create the related tasks to be executed.

10 In the Task Viewer you can now follow the progress of the task execution.

|I| Please note:
Once the ESW has been upgraded on any FOX61x NE, a force poll of the NE is
recommended in FOXMAN-UN after the ESW has started.

When executed successfully, all core and service units of the FOX61x network elements run the
software of the R18 system release packet.

Upgrade via FOXCST

NOTICE Non-observance could result in equipment damage.

Upgrading Embedded Software of FOX61x network elements from ESW released
prior to R14A to ESW released with R18 may result in non-operational units.

— FOX61x network elements running on ESW from any system release other than
R14A must first be upgraded to the system release R14A before further upgrad-
ing. Please refer to the corresponding upgrade Engineering Bulletin or Applica-
tion Note.

— Use FOXCST R18 for connecting to the network elements and for downloading
and installing the new ESW.
The following upgrade method is described in this Application Note:
* Upgrade using the FOXCST GUI with the “Tools > Software Download ...” function, for which
a detailed description is provided.

For the preferred upgrade method using the FOXMAN-UN GUI with the “ESW Management -
Distribution Wizard” function refer to section 3.2.2 Upgrade via FOXMAN-UN (ESW Distribution
Wizard) (on page 17).

There are other possible ways to upgrade a FOX61x, like an upgrade using the FOXCST GUI
with manual upgrade of each unit; however these methods are not recommended and are not
covered in the present Application Note.

|I| Please note:
You may only perform the upgrade to system release R18 if all prerequisites given
below are fulfilled.
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Risk of operating trouble!
The use of weak or empty passwords for accessing FOX61x nodes bears a high

risk of unauthorized access, service unavailability, and equipment damage.

— We strongly recommend to set strong passwords for all user classes once
FOXCST R18 is installed and set up.

Risk of operating trouble!
Any deviation from the steps described herein for the upgrade procedure conceal a

risk of operating trouble after the upgrade procedure.

— Make sure you follow these steps to minimize the risk of system unavailability or
malfunction.

Prerequisites:

Your FOX61x equipment needs to fulfill the following prerequisites before the upgrade proce-
dure can be started.

* Unit ESW has System Release R17A Status (on page 19),

* Management Connection to the Active Core Unit (on page 20),
» Equipment is Fault Free (on page 21),

* Correct FOXCST Version is being used (on page 21).

These prerequisites are described in more detail below.

Unit ESW has System Release R17A Status

All units need to run

» the latest embedded software (ESW) that had been released in the scope of the FOX61x
system release R17A,

i.e. the units and their ESW are of the types and versions shown in Table 2.

Table 2: Upgradeable Units and ESW with System Release R17A
Unit name Upgrade from To
R17A ESW ! R18 ESW 2

CESM1, CESM1-F
CESM1 (NE Controller)
CESM2, CESM2-F cesun_r17a01_03
CESM2 (NE Controller) cesne_r17a01_03
CESM3 cesm3_r17a01_03
BIGO1 bigo1_r17a01
CEPI1 (R1, R2 HW) cepi1_r4b07_01
CEPI1 (R3 HW) cepi1_r17b02

cesun_r17a01_03
cesne_r17a01_03

cesun_r18a01

cesne_r18a01

cesun_r18a01

cesne_r18a01

cesm3_r18a01
bigo1_r18a01
No upgrade required; keep ESW version.

cepi1_r18a01

COosi

cosi1_r4b02_03

No upgrade required; keep ESW version.

DATI1

dati1_r5e02_11

No upgrade required; keep ESW version.

DEFM1, DEFM1-F

defm1_r17a01

defm1_r18a01

ELET1

elet1_r17a01_03

elet1_r18a01

EPEX1 epex1_r17a01 epex1_r18a01
EPOI1 epoi1_r17a01 epoi1_r18a01
EPSI1 epsi1_r2c02_11 No upgrade required; keep ESW version.

EROP1, EROP1-F

erop1_r17a01_03

erop1_r18a01

ESOP1, ESOP1-F

esop1_r17a01_03

esop1_r18a01

ESPO1

espo1_r17a01_03

espo1_r18a01

ETOP1, ETOP1-F

etop1_r17a01_03

etop1_r18a01
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Table 2: Upgradeable Units and ESW with System Release R17A (continued)
Unit name Upgrade from To
R17AESW ' R18 ESW ?

FOX610 (Unit)

f10un_r17a01_03

f10un_r18a01

FOX610 (NE Controller)

f10ne_r17a01_03

f10ne_r18a01

LECO1 lecal_r1a02_04 No upgrade required; keep ESW version.
leco1_r1d03_02 No upgrade required; keep ESW version.
LEDA1 leda1_r2d02_02 No upgrade required; keep ESW version.

LEDE1 (R1 HW

lede1 _r5¢c02_02

No upgrade required; keep ESW version.

LEDE1 (R2 HW

lede1_r17a01_01

lede1_r18a01

)
)
)
)

LEDS1 (R1 HW leds1_r2g02 leds1_r2g02_02

LEDS1 (R2 HW leds1_r17a01_01 leds1_r18a01

LESU1 lesu1_r2d03 No upgrade required; keep ESW version.
LEXI1 lexi1_r2c03_05 No upgrade required; keep ESW version.

ODIS1 (R1 HW)

odis1_r17a01_03

odis1_r18a01

ODIS1 (R2 HW)

odis1r2_r17a01_03

odis1r2_r18a01

OPIC1

opic1_r1d02_01

opic1_r1d02_02

OPIC2 (R1 HW)

opic2_r17a01_03

opic2_r18a01

OPIC2 (R2 HW)

opic2r2_r17a01_03

opic2r2_r18a01

SAMO1

samo1_r3g01_06

No upgrade required; keep ESW version.

SAMO2, SAMO2-F

samo2_r17a01_03

samo2_r18a01

SAMO3

samo2_r17a01_03

samo2_r18a01

SAMO5, SAMO5-F

samo2_r17a01_03

samo2_r18a01

SENC1, SENC1-F

No upgrade possible.

No upgrade possible.

SENC1-4, SENC1F4,
SENC1-8, SENC1F8

app-416_r17a06

app-416_r18a01

TEGO1 tego1_r17a01 tego1_r18a01
TEPI1 tepi1_r2c01 No upgrade required; keep ESW version.
TEPI2 tepi2_r17a01 tepi2_r18a01
VFTLF vitlf_ r1a06 No upgrade required; keep ESW version.

1. The latest version, including hotfixes (where available) is required. If the ESW is not on the mentioned
version yet, first upgrade to this version.

2. Use the latest version available in accordance with the FOX61x R18 Release Note or the latest hotfix
where available. Hotfixes may have been published after this document was issued.

|I| Please note:
Make sure that, prior to the upgrade from R17A, you have installed the latest ESW
that corresponds to the versions released with the system release R17A, including
the latest hotfix where available, for all units in any network element to be

upgraded.

If you have a unit or ESW that is not listed in Table 2, please contact Hitachi
Energy technical support (see section 6.2 Technical Support (on page 36)).

If you have units running embedded software of a system release that is older than
what is listed in Table 2, please contact Hitachi Energy technical support (see sec-

tion 6.2 Technical Support (on page 36)).

Management Connection to the Active Core Unit

If you are using the local management port of the CESM1, CESM2 or CESM3, make sure that
you have the port of the active CESM1, CESM2 or CESM3 connected to your PC.

Copyright 2025 Hitachi Energy. All rights reserved.
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|I| Please note:

When doing an ESW download while using CESM1, CESM2 or CESM3 redun-
dancy use the start “Algorithm” parameter “System Release Upgrade”. With “Sys-
tem Release Upgrade”, the system will make sure that core unit in slot 11 will be
the active core unit after the upgrade (independent of which unit was active before
the upgrade).

Equipment is Fault Free

Make sure that the equipment (i.e. all units that are operated in the NE) has the equipment state
“Ok” (check each unit in the “Tree View” of the FOXCST), and that it is free of equipment related
alarms such as hardware or software incompatibilities or units that are unassigned.

Correct FOXCST Version is being used

When using the FOXCST GUI and “Tools > Software Download ...”, make sure you have a PC
running a supported Windows® version, with an installed element manager FOXCST R18 (file
name FOXCST_18.0.0-0.exe). For information on how to install the FOXCST refer to
[TKHWO002466] User Manual “FOXCST” (FOX61x R18).

For version details of the FOXCST to be installed, refer to [1KHW028777] Release Note “FOX-
61x R18”.

Limitations for the Upgrade

Risk of operating trouble!
Incomplete ESW selection for the upgrade will lead to incompatibilities and service

interruptions, and can even lead to the loss of the management connection.

— If you miss a unit that needs to be upgraded the old unit ESW will be incompati-
ble with the new ESW of the upgraded units. Therefore always select all units
for upgrade that are operated in your NE as listed in Table 2 before executing
“Download and Start...” or “Start...”.

Risk of operating trouble!
Please note that the upgrade procedure will interrupt services for up to a few min-

utes.

— If you do not want services to be interrupted at the moment, do not perform the
upgrade now but choose a time for the upgrade when the impact of service
interruptions on customers is minimal.

— As an alternative you may want to download the new ESW to the FOX61x
without installing the new ESW and without re-starting the units yet. This
reduces the risk of a failed upgrade. Also see steps 8. to 11. in the following
procedure, but selecting “Download” in step 11., and only select “Start...” after
all ESW files have been downloaded. Note: The open “Software Download” dia-
log blocks any further FOXCST action.

|I| Please note:
The ESW upgrade for the SENC1-4, SENC1F4, SENC1-8, and SENC1F8 encryp-
tion units cannot be done with the procedure described in section 3.2.3.6 Step-by-
Step Procedure (on page 22).

— For a description of the SENC1-4, SENC1F4, SENC1-8, and SENC1F8 units
specific ESW upgrade procedure please refer to [1TKHW029028] User Manual
“SENC1-4, SENC1F4, SENC1-8, SENC1F8”.

|I| Please note:
The risk of failed upgrades can be further reduced by running only one FOXCST
instance on one PC.
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Step-by-Step Procedure

The following order of actions is required for upgrading FOX61x with a system release R17A
state to ESW that is part of the system release R18.

ESW upgrade procedure

Proceed as follows:

1. Start the FOXCST.

2. Select the menu command “File - Manage ESW ...".

3. In the “ESW Package Manager” dialog window click on the “Import” button.

- Browse to the appropriate folder or file source containing the new ESW and SIM files (see
the appropriate columns in Table 2).

- Select the ESW zip file needed to get your units to the “R18” status.

- Click on the “Open” button.

- Select the software types (all, .esw, .sim, none) to be imported.

- Wait until all ESW files have been imported.

- Close the “ESW Package Manager” dialog with the “Close” button.

4. Connect to the FOX61x to be upgraded (via the menu command “File - Connect ...”) with the
“User Class” set to “Manager”.

5. Check the equipment.

- Make sure the equipment status (FOXCST “Tree View”) is “Ok” for all units to be
upgraded. If this is not the case, take the appropriate measures to correct this before pro-
ceeding.

- Make sure there are no equipment related alarms active (FOXCST “Alarms” view). If you
have equipment alarms, take the appropriate measures to correct this before proceeding.

6. Perform a “Save to NE” operation to store the current running configuration to the NE data-
base.

7. Create a backup (to your PC) of the network element configuration.

- This is done on the FOXCST GUI by using the menu selection “File - Save Configuration
To Disk ...” or “File - Save Configuration To Disk As ...".

|I| Please note:
FOXCST keeps the file name; without disconnection/reconnection, a later config
save overwrites this original saved file without confirmation dialog.

8. Start the software download manager.

- Select the menu command “Tools - Software Download ...".
- Wait until all plugged units are listed in the table.

9. Configure the software download.

- In the “Available System Releases” selection box select the system release “R18 (FOX-
61x)".

- Check the “Software to install” column of all units to show the correct Software for the
unit, including the core unit (one or two CESM1, (CESM2) or CESM3) and the core unit's
neController (CESM1 (and CESM2) only) (see Table 2).

- The “Status” column shows “Software needs to be downloaded”, “Software is down-
loaded”, or “Software is running”, depending on the current condition.

- Mark the checkboxes “Delete unused software” to make sure there is enough space in
the flash memory of the unit.

10.Double check that all settings displayed in the “Software Download” table are correct.
11.Start the upgrade

- When all required units are configured, click on the “Download and Start ...” button.
- When prompted with “Parameters for command Download and Start” set the Algorithm to
“System Release Upgrade”:
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Algarithm: | System Release Upgrade v

QK Cancel

- Click “OK” to apply the settings and start the upgrade process.

- This will first delete unused software (ESW) files where necessary, download the new
software (ESW) to the units to be upgraded, then restart the ESW on the units to be
upgraded.

- Do not close the “Software Download” dialog while the upgrade process is running.

12.Since you will lose the management connection to the FOX61x during the restart of the core
unit(s), you need to re-connect to the FOX61x when the ESW upgrade has been completed.

13.After re-connecting check that everything is OK with the upgraded core unit(s) and service
units.

14.Perform a “Save to NE” operation.
- This will create a new database.
15.Create a backup (to your PC) of the network element configuration.
- This is done on the FOXCST GUI by using the menu selection “File - Save Configuration
to Disk ...” or “File - Save Configuration to Disk As ...”.
Result: You have successfully upgraded your FOX61x.
End of instruction

|I| Please note:
If the upgrade was not successful for any reason, you might need to restore the
backup configuration (i.e. the file stored to your PC in step 7. above) to your FOX-
61x. This is done by downloading the saved FOX61x R17A backup file to the NE.

— Before downloading the saved backup file make sure that the ESW files used in
the R17A system release, respectively, are still available on the units. If
required for any reason, download all missing ESW files via the FOXCST menu
function “File > Manage ESW ... > Import”.

— Download the backup file via the FOXCST menu function “NE > Download Con-
figuration ...”. Select the previously stored .tar file to be downloaded.

— If the conditions remain that have led to an unsuccessful upgrade contact Hita-
chi Energy technical support (see section 6.2 Technical Support (on page 36))
for assistance.

Post-upgrade steps

In certain cases, some MPLS-TP services may appear as “Deployed Invalid” in ENP after the
database has been restored and the FOXMAN-UN services are started. This may be the case
e.g. if modifications to the MPLS-TP configuration made with FOXCST have not been loaded to
the FOXMAN-UN database. The following steps will resolve this:

1 Execute a force poll on all nodes.
2 Check the services status again in ENP.

3 If there are still services with status “Deployed Invalid”, execute a “Clear and Synchronize” in
ENP by selecting the menu option “Network - Clear and Synchronize”. This menu option
requires Expert Mode to be active. To activate it, select “Options - Expert Mode” from the
ENP menu.

“Clear and Synchronize” will clear the services from the database and load them again from
all nodes in the network. Wait until this has been terminated. The services should now all
have “Deployed Valid” status.

4 Align all ENP services (VPLS and VPWS) from the ENP main window that are not aligned.
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Upgrade R16B to R18

]

Please note:

FOXMAN-UN and DIRAC of system release R18 require a RHEL 9.6 operating
system. It is recommended to prepare a new separate RHEL 9.6 server or VM for
FOXMAN-UN R18. The old RHEL server machine or VM, used by the FOXMAN-
UN before system release R18, can be switched off once the system upgrade is
successfully completed.

Be aware that if you want to be able to use the FOXMAN-UN R16B and R18 clients
on Windows at the same time, they need to be installed on separate machines.
Also refer to the FOXMAN-UN R18 release note for more details on the upgrade
procedure.

If you do not have a new server HW or VM available, upgrade via the basic steps:

+ Create database backup on installation prior to upgrade and save it to a secure
folder.

* Uninstall current FOXMAN-UN R16B.

+ Upgrade RHEL OS to version 9.6.

» Install FOXMAN-UN R18 core and add-ons as required. Install R18 client(s).
* Restore database backup from old installation to the new R18 installation.

» Start NEM services (nemstart), then log in from client.

+ Recommended: Execute a force poll of each managed node.

» Make sure to still follow the steps listed below (except the one to provide a new
server or VM).

FOXMAN-UN and DIRAC upgrade

FOXMAN-UN R18 Installation on RHEL 9.6 Server

Follow the steps below to install the FOXMAN-UN and DIRAC of system release R18 on a
RHEL 9.6 server:

1 Install RHEL 9.6 on an appropriate server or VM.
2 Install FOXMAN-UN R18 on the RHEL 9.6 server.

Apply the FOXMAN-UN R18 license on the RHEL 9.6 server. If you are using MPLS-TP tun-
nel encryption with SENC1 units and DIRAC, the license must include the DIRAC feature.

3 Install R18 NEM_ADDONS as required.

]

While coming from R16B, do also install DIRAC if you are using the ESM (Ethernet
Security Manager) feature.

Please note:

The new R18 RHEL 9.6 server will most likely have a different IP address than the
old RHEL server used by the FOXMAN-UN before system release R18. Therefore
agent IP addresses need to be adjusted accordingly.

This can be done manually once the database is restored and services are run-
ning.

Another option is to setup a “/opt/nem/etc/iptranslate.cont” file and use
the “-a” key during the database restore:

edbrestore -b <database name> -a.

— In this way, the agent IP addresses will be automatically adjusted according to
the information in the “iptranslate.conf” file.
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Upgrade FOXMAN-UN database from R16B to R18

For an upgrade from R16B to R18, the procedure is considering that the DIRAC database is
compatible between R16B and R18. Follow the steps below:

1

Perform a force poll on all network elements on your existing (old) FOXMAN-UN server.
The network should be as stable and alarm free as possible. Take note of the following:
- Any present alarms and unmanaged network element.

- Anything in invalid state on NP, ESM and ENP.

Create a backup of the NEM database on your existing (old) FOXMAN-UN server.

Create a backup of the following files from the folder “/opt/nem/etc” on your existing (old)
FOXMAN-UN server:

/opt/nem/etc/iptranslate.conf
/opt/nem/etc/firewall.conf
Create a backup of the following files if they are present:
/opt/nem/etc/cst1_license.xml
/opt/nem/etc/npfotool_crossconnect.csv
/opt/nem/etc/npfotool_termination.csv
/opt/nem/etc/npfotool_trailhierarchy.csv
Restore the backed-up files from /opt/nem/etc on the new R18 RHEL 9.6 server.
Restore the backed-up NEM database on the new R18 RHEL 9.6 server.

Some general information on the database upgrade is given in [1KHW002414] User Manual
“FOXMAN-UN under Linux”.

Start FOXMAN-UN services by executing nemstart.

|I| Please note:
In networks with 1000 or more NEs, the initialization of the NMS system can take

between 20 and 30 minutes. The system is not fully operational during this time.

7 Once the FOXMAN-UN services are running, log in to FOXMAN-UN and check the NEM

Browser, Networking Package (NP), Ethernet Security Manager (ESM) and Ethernet Net-
working Package (ENP). Refer to the following table for the status:

Item Status

NEM Browser  All network elements are manageable and are alarm free. 1

NP The status matches the one on the server of the previous release.

ESM All Crypto Engines have the Communication Status “Manageable”. Note that it may
take some time until this status is shown.

ESM The port mappings are present.

ENP All encrypted tunnels have the Encryption Status “Valid” and the Status “Deployed
Valid”.

ENP VPLS, VPWS, Pseudo Wire, Link, NE and Service Profile are in the same state as

on the server of the previous release. Some services may be “Unaligned”.

1. On a customer network there might be alarms or unmanageable network elements present before the
upgrade. The alarm and network element situation on the new R18 server should match the situation
on the server of the previous release.

All network elements still run the ESW of the old system release (R16B) but are now man-
aged by FOXMAN-UN R18.

MPLS Service migration: MPLS services without control word (if there are any) must be
migrated to services with control word. Control word shall be migrated before upgrading the
nodes, else there is a risk to lose packets due to time stamping non PTP packets on SENC1
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4.2.1
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or EPEX1 units. It is recommended to do this step even if you currently do not operate
SENC1 or EPEX1 units.

Therefore, execute the script “Set PW Control Word” from the FOXMAN-UN - R18 “NEM
Desktop - System - Remote Executor...”. Execute the script service by service, node by node
or network-wide, as preferred.

9 Upgrade FOX61x network elements ESW to R18. For details see section 4.2.2 Upgrade via
FOXMAN-UN (on page 27).

10 If any services appear invalid or unaligned after the NE ESW upgrade has been successfully
terminated, execute the steps in section 4.1.3 "Post-upgrade steps".

11 If your setup includes Foreign Objects (FO), follow the instructions given in section 5 Foreign
Object (FO) Upgrade to R18 (on page 35).

12 Once the new system is stable, disconnect or uninstall the old FOXMAN-UN.

Post-upgrade steps

In certain cases, some MPLS-TP services may appear as “Deployed Invalid” in ENP after the
database has been restored and the FOXMAN-UN services are started. This may be the case
e.g. if modifications to the MPLS-TP configuration made with FOXCST have not been loaded to
the FOXMAN-UN database. The following steps will resolve this:

1 Execute a force poll on all nodes.
2 Check the services status again in ENP.

3 If there are still services with status “Deployed Invalid”, execute a “Clear and Synchronize” in
ENP by selecting the menu option “Network - Clear and Synchronize”. This menu option
requires Expert Mode to be active. To activate it, select “Options - Expert Mode” from the
ENP menu.

“Clear and Synchronize” will clear the services from the database and load them again from
all nodes in the network. Wait until this has been terminated. The services should now all
have “Deployed Valid” status.

4 Align all ENP services (VPLS and VPWS) from the ENP main window that are not aligned.

FOX61x upgrade

This section describes the FOX61x nodes upgrade.

Pre-upgrade steps

Before starting the node upgrade, perform the following step:

1 MPLS Service migration: MPLS services without control word (if there are any) must be
migrated to services with control word. Control word shall be migrated before upgrading the
nodes, else there is a risk to lose packets due to time stamping non PTP packets on SENC1
or EPEX1 units. It is recommended to do this step even if you currently do not operate
SENC1 or EPEX1 units.

Therefore, execute the script “Set PW Control Word” from the FOXMAN-UN - R18 “NEM
Desktop - System - Remote Executor...”. Execute the script service by service, node by node
or network-wide, as preferred.

Risk of operating trouble!
After upgrading to R18, packets without PW control word may get time stamped
even they are not PTP packets, this may result in packet loss.

Risk of operating trouble!
Make sure that ENP services are in valid state before starting the service migration

with the Remote Executor tool.
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422 Upgrade via FOXMAN-UN

ﬂ NOTICE Non-observance could result in equipment damage.
Upgrading Embedded Software of FOX61x network elements from ESW released
prior to R18 to ESW released with R18 before having upgraded FOXMAN-UN to
R18 may result in incompatibility of FOXMAN-UN and FOX61x network elements
software and cause unpredictable behavior.
— Always upgrade FOXMAN-UN to R18 before upgrading any ESW of FOX61x
network elements to R18.

ﬂ NOTICE Non-observance could result in equipment damage.
Upgrading Embedded Software of FOX61x network elements from ESW released
prior to R14A to ESW released with R18 may result in non-operational units.

— FOX61x network elements running on ESW from any system release other than
R14A must first be upgraded to the system release R14A before further upgrad-
ing. Please refer to the corresponding upgrade Engineering Bulletin or Applica-
tion Note.

Follow the steps in the FOXMAN-UN ESW Distribution Wizard recommended below to upgrade
the FOX61x network elements to system release R18:

|I| Please note:
The procedure below excludes the SENC1 units. For the upgrade of the SENC1-4,
SENC1F4, SENC1-8, SENC1F8 refer to section 4.2.5 SENC1 Software upgrade to
R18 (on page 33).
1 Select “Network - ESW Management - ESW Distribution Wizard” from the NEM Desktop
menu to create an ESW distribution job; give the job an appropriate name. Click “Next >”.

2 Mark “Download ESW on all Units”, “Delete oldest unassigned ESW before”, “Start ESW on
all Units”; if you are using equipment protection, do not mark “Minimal Service Interruption -
Revertive EQP” or “Minimal Service Interruption - Non-Revertive EQP”, but mark “System
Release Upgrade”. Optionally mark “Abort on first Error”. Click “Next >”.

3 Import R18 ESW ZIP archive via the “Import ESW...” button, then select “R18” in the
“Desired System Release” drop-down box. Select all applicable ESW from the “Select ESW”
list. Do not select the SENC1-4, SENC1F4, SENC1-8, SENC1F8 units. Make sure the cor-
rect ESW version is selected for each unit. Click “Next >”.

4 Select the NEs to be upgraded. Click “Next >”.

5 Expand all NEs. Verify “Current ESW Version” and “ESW to Install” for each NE and unit.
When OK, click “Next >”".

6 Set the processing order of NEs in accordance with network specific requirements. Click
“Next >”.

7 If required, rearrange the NEs in groups. When OK, click “Next >".
8 Set the schedule actions as required. When OK, click “Next >”.

9 Mark “Launch the ‘Task Viewer’ upon <Activate>", then click “Activate” to activate the job
and create the related tasks to be executed.

10 In the Task Viewer you can now follow the progress of the task execution.

|I| Please note:
Once the ESW has been upgraded on any FOX61x NE, a force poll of the NE is
recommended in FOXMAN-UN after the ESW has started.

When executed successfully, all core and service units of the FOX61x network elements run the
software of the R18 system release packet.
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Upgrade via FOXCST

ﬂ NOTICE Non-observance could result in equipment damage.

4.2.3.1

Upgrading Embedded Software of FOX61x network elements from ESW released
prior to R14A to ESW released with R18 may result in non-operational units.

— FOX61x network elements running on ESW from any system release other than
R14A must first be upgraded to the system release R14A before further upgrad-
ing. Please refer to the corresponding upgrade Engineering Bulletin or Applica-
tion Note.

— Use FOXCST R18 for connecting to the network elements and for downloading
and installing the new ESW.
The following preferred upgrade method is described in this Application Note:
* Upgrade using the FOXCST GUI with the “Tools > Software Download ...” function, for which
a detailed description is provided.
For the upgrade using the FOXMAN-UN GUI with the “ESW Task” function refer to section 4.2.2
Upgrade via FOXMAN-UN (on page 27).

There are other possible ways to upgrade a FOX61x, like an upgrade using the FOXCST GUI
with manual upgrade of each unit; however these methods are not recommended and are not
covered in the present Application Note.

|I| Please note:
You may only perform the upgrade to system release R18 if all prerequisites given
below are fulfilled.
Risk of operating trouble!
The use of weak or empty passwords for accessing FOX61x nodes bears a high

risk of unauthorized access, service unavailability, and equipment damage.

— We strongly recommend to set strong passwords for all user classes once
FOXCST R18 is installed and set up.

Risk of operating trouble!
Any deviation from the steps described herein for the upgrade procedure conceal a

risk of operating trouble after the upgrade procedure.

— Make sure you follow these steps to minimize the risk of system unavailability or
malfunction.

Prerequisites:

Your FOX61x equipment needs to fulfill the following prerequisites before the upgrade proce-
dure can be started.

* Unit ESW has System Release R16B Status (on page 28),

* Management Connection to the Active Core Unit (on page 30),
» Equipment is Fault Free (on page 30),

» Correct FOXCST Version is being used (on page 30).

These prerequisites are described in more detail below.

Unit ESW has System Release R16B Status

All units need to run

» the latest embedded software (ESW) that had been released in the scope of the FOX61x
system release R16B,

i.e. the units and their ESW are of the types and versions shown in Table 3.
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Table 3: Upgradeable Units and ESW with System Release R16B
Unit name Upgrade from To
R16B ESW ' R18 ESW 2

CESM1, CESM1-F

cesun_r16b04_11

cesun_r18a01

CESM1 (NE Controller)

cesne_r16b04_11

cesne_r18a01

CESM2, CESM2-F

cesun_r16b04_11

cesun_r18a01

CESM2 (NE Controller)

cesne_r16b04_11

cesne_r18a01

CESM3 cesm3_r16b04_11 cesm3_r18a01

CEPI1 (R1, R2 HW) cepil1_r4b07_01 No upgrade required; keep ESW version.
cosn cosi1_r4b02_03 No upgrade required; keep ESW version.
DATIM dati1_r5e02_11 No upgrade required; keep ESW version.
DEFM1, DEFM1-F defm1_r16b04 defm1_r18a01

ELET1 elet1_r16b04_11 elet1_r18a01

EPEX1 epex1_r16b04 epex1_r18a01

EPOI1 epoi1_r16b04 epoi1_r18a01

EPSI1 epsi1_r2c02_11 No upgrade required; keep ESW version.

EROP1, EROP1-F

erop1_r16b04_11

erop1_r18a01

ESOP1, ESOP1-F

esop1_r16b04_11

esop1_r18a01

ESPO1

espo1_r16b04_11

espo1_r18a01

ETOP1, ETOP1-F

etop1_r16b04_11

etop1_r18a01

FOX610 (Unit)

f10un_r1b604_11

f10un_r18a01

FOX610 (NE Controller)

f10ne_r1b604_11

f10ne_r18a01

LECO1 leco1_r1d03_02 No upgrade required; keep ESW version.
leca1_r1a02_04 No upgrade required; keep ESW version.

LEDA1 leda1_r2d02_02 No upgrade required; keep ESW version.

LEDE1 R1 HW lede1_r5c02_02 No upgrade required; keep ESW version.

LEDE1 R2 HW lede1_r17a01_01 lede1_r18a01

LEDS1 R1 HW leds1_r2g02 No upgrade required; keep ESW version.

LEDS1 R2 HW leds1_r16c02 leds1_r18a01

LESU1 lesu1_r2d03 No upgrade required; keep ESW version.

LEXI1 lexi1_r2c03_05 No upgrade required; keep ESW version.

ODIS1 R1 HW odis1_r16b04_11 odis1_r18a01

ODIS1 R2 HW odis1r2_r16c02_03 odis1r2_r18a01

OPIC1 opic1_r1d02_01 opic1_r1d02_02

OPIC2 R1 HW opic2_r16b04_11 opic2_r18a01

OPIC2 R2 HW opic2r2_r16c02_03 opic2r2_r18a01

SAMO1 samo1_r3g01_06 No upgrade required; keep ESW version.

SAMO2, SAMO2-F samo2_r16b04_11 samo2_r18a01

SAMO3 samo2_r16b04_11 samo2_r18a01

SAMO5, SAMOS5-F

samo2_r16b04_11

samo2_r18a01

SENC1, SENC1-F

No upgrade possible.

No upgrade possible.

SENC1-4, SENC1F4,
SENC1-8, SENC1F8

app-416_r16b03_01

app-416_r18a01, see section 4.2.5.

TEGO1 tego1_r16b04 tego1_r18a01

TEPI1 tepi1_r2b02 tepi1_r2c01

TEPI2 tepi2_r16b04_11 tepi2_r18a01

VFTLF vftlf_ r1a06 No upgrade required; keep ESW version.
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1. The latest version, including hotfixes (where available) is required. If the ESW is not on the mentioned
version yet, first upgrade to this version.

2. Use the latest version available in accordance with the FOX61x R18 Release Note or the latest hotfix
where available. Hotfixes may have been published after this document was issued.

|I| Please note:

Make sure that, prior to the upgrade from R16B, you have installed the latest ESW
that corresponds to the versions released with the system release R16B, including
the latest hotfix where available, for all units in any network element to be
upgraded.

If you have a unit or ESW that is not listed in Table 3, please contact Hitachi
Energy technical support (see section 6.2 Technical Support (on page 36)).

If you have units running embedded software of a system release that is older than
what is listed in Table 3, please contact Hitachi Energy technical support (see sec-
tion 6.2 Technical Support (on page 36)).

Management Connection to the Active Core Unit

If you are using the local management port of the CESM1, (CESM2) or CESM3, make sure that
you have the port of the active CESM1, (CESM2) or CESM3 connected to your PC.

|I| Please note:

When doing an ESW download while using CESM1, CESM2 or CESM3 redun-
dancy use the start “Algorithm” parameter “System Release Upgrade”. With “Sys-
tem Release Upgrade”, the system will make sure that core unit in slot 11 will be
the active core unit after the upgrade (independent of which unit was active before
the upgrade).

Equipment is Fault Free

Make sure that the equipment (i.e., all units that are operated in the NE) has the equipment
state “Ok” (check each unit in the “Tree View” of the FOXCST), and that it is free of equipment
related alarms such as hardware or software incompatibilities or units that are unassigned.

Correct FOXCST Version is being used

When using the FOXCST GUI and “Tools > Software Download ...”, make sure you have a PC
running a supported Windows® version, with an installed element manager FOXCST R18 (file
name FOXCST_18.0.0-0.exe). For information on how to install the FOXCST refer to
[1TKHWO002466] User Manual “FOXCST” (FOX61x R18).

For version details of the FOXCST to be installed, refer to [1KHW028777] Release Note “FOX-
61x R18".

Limitations for the Upgrade

Risk of operating trouble!
Incomplete ESW selection for the upgrade will lead to incompatibilities and service

interruptions, and can even lead to the loss of the management connection.

— If you miss a unit that needs to be upgraded the old unit ESW will be incompati-
ble with the new ESW of the upgraded units. Therefore always select all units
for upgrade that are operated in your NE as listed in Table 3 before executing
“Download and Start...” or “Start...”.
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Risk of operating trouble!
Please note that the upgrade procedure will interrupt services for up to a few min-

utes.

— If you do not want services to be interrupted at the moment, do not perform the
upgrade now but choose a time for the upgrade when the impact of service
interruptions on customers is minimal.

— As an alternative you may want to download the new ESW to the FOX61x
without installing the new ESW and without re-starting the units yet. This
reduces the risk of a failed upgrade. Also see steps 8. to 11. in the following
procedure, but selecting “Download” in step 11., and only select “Start...” after
all ESW files have been downloaded. Note: The open “Software Download” dia-
log blocks any further FOXCST action.

|I| Please note:
The ESW upgrade for the SENC1-4, SENC1F4, SENC1-8, and SENC1F8 encryp-

tion units cannot be done with the procedure described in section 4.2.3.6 Step-by-

Step Procedure (on page 31).

— For a description of the SENC1-4, SENC1F4, SENC1-8, and SENC1F8 units
specific ESW upgrade procedure please refer to [1TKHW029028] User Manual
“SENC1-4, SENC1F4, SENC1-8, SENC1F8” and to section 4.2.5 SENC1 Soft-
ware upgrade to R18 (on page 33).

|I| Please note:
The risk of failed upgrades can be further reduced by running only one FOXCST

instance on one PC.

4.2.3.6 Step-by-Step Procedure

The following order of actions is required for upgrading a FOX61x with a system release R16B
state to ESW that is part of the system release R18.

ESW upgrade procedure
Proceed as follows:

1.
2.
3.

Start the FOXCST.
Select the menu command “File - Manage ESW ...".
In the “ESW Package Manager” dialog window click on the “Import” button.

- Browse to the appropriate folder or file source containing the new ESW and SIM files (see
the appropriate columns in Table 3).

- Select the ESW zip file needed to get your units to the “R18” status.

- Click on the “Open” button.

- Select the software types (all, .esw, .sim, none) to be imported.

- Wait until all ESW files have been imported.

- Close the “ESW Package Manager” dialog with the “Close” button.

Connect to the FOX61x to be upgraded (via the menu command “File - Connect ...”) with the
“User Class” set to “Manager”.

Check the equipment.

- Make sure the equipment status (FOXCST Tree View) is “Ok” for all units to be upgraded.
If this is not the case, take the appropriate measures to correct this before proceeding.

- Make sure there are no equipment related alarms active (FOXCST “Alarms” view). If you
have equipment alarms, take the appropriate measures to correct this before proceeding.

. Perform a “Save to NE” operation to store the current running configuration to the NE data-

base.
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7. Create a backup (to your PC) of the network element configuration.

- This is done on the FOXCST GUI by using the menu selection “File - Save Configuration
To Disk ...” or “File - Save Configuration To Disk As ...".

|I| Please note:
FOXCST keeps the file name; without disconnection/reconnection, a later config
save overwrites this original saved file without confirmation dialog.
8. Start the software download manager.
- Select the menu command “Tools - Software Download ...".
- Wait until all plugged units are listed in the table.
9. Configure the software download.

- In the “Available System Releases” selection box select the system release “R18 (FOX-
61x)".

- Check the “Software to install” column of all units to show the correct Software for the
unit, including the core unit (one or two CESM1, (CESM2) or CESM3) and the core unit's
neController (CESM1 (and CESM2) only) (see Table 3).

- The “Status” column shows “Software needs to be downloaded”, “Software is down-
loaded”, or “Software is running”, depending on the current condition.

- Mark the checkboxes “Delete unused software” to make sure there is enough space in
the flash memory of the unit.

10.Double check that all settings displayed in the “Software Download” table are correct.
11.Start the upgrade

- When all required units are configured, click on the “Download and Start ...” button.
- When prompted with “Parameters for command Download and Start” set the Algorithm to
“System Release Upgrade”:

Algorithm: | System Release Upgrade ¥

QK Cancel

- Click “OK” to apply the settings and start the upgrade process.

- This will first delete unused software (ESW) files where necessary, download the new
software (ESW) to the units to be upgraded, then restart the ESW on the units to be
upgraded.

- Do not close the “Software Download” dialog while the upgrade process is running.

12.Since you will lose the management connection to the FOX61x during the restart of the core
unit(s), you need to re-connect to the FOX61x when the ESW upgrade has been completed.

13.After re-connecting check that everything is OK with the upgraded core unit(s) and service
units.

14.Perform a “Save to NE” operation.
- This will create a new database.
15.Create a backup (to your PC) of the network element configuration.
- This is done on the FOXCST GUI by using the menu selection “File - Save Configuration
to Disk ...” or “File - Save Configuration to Disk As ...".
Result: You have successfully upgraded your FOX61x.
End of instruction

|I| Please note:
If the upgrade was not successful for any reason, you might need to restore the
backup configuration (i.e. the file stored to your PC in step 7. above) to your FOX-
61x. This is done by downloading the saved FOX61x R16B backup file to the NE.

— Before downloading the saved backup file make sure that the ESW files used in
R16B system release are still available on the units. If required for any reason,
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download all missing ESW files via the FOXCST menu function “File > Manage
ESW ... > Import”.

— Download the backup file via the FOXCST menu function “NE > Download Con-
figuration ...”. Select the previously stored .tar file to be downloaded.

— If the conditions remain that have led to an unsuccessful upgrade contact Hita-
chi Energy technical support (see section 6.2 Technical Support (on page 36))
for assistance.

4.2.4 Post-upgrade steps

In certain cases, some MPLS-TP services may appear as “Deployed Invalid” in ENP after the
database has been restored and the FOXMAN-UN services are started. This may be the case
e.g. if modifications to the MPLS-TP configuration made with FOXCST have not been loaded to
the FOXMAN-UN database. The following steps will resolve this:

1
2
3

Execute a force poll on all nodes.

Check the services status again in ENP.

If there are still services with status “Deployed Invalid”, execute a “Clear and Synchronize” in
ENP by selecting the menu option “Network - Clear and Synchronize”. This menu option
requires Expert Mode to be active. To activate it, select “Options - Expert Mode” from the
ENP menu.

“Clear and Synchronize” will clear the services from the database and load them again from
all nodes in the network. Wait until this has been terminated. The services should now all
have “Deployed Valid” status.

Align all ENP services (VPLS and VPWS) from the ENP main window that are not aligned.

4.2.5 SENC1 Software upgrade to R18

After the NE upgrade, the SENC1-4, SENC1F4, SENC1-8, SENC1F8 units still run r16b03_01
software and are not yet upgraded. To upgrade SENC1 software to system release R18, follow
these steps:

1

Copy the R18 SENC1 software tar file to the folder “/opt/dirac/addon/ESW” on the FOXMAN-
UN server (dirac user permissions are required for this).

Open the Ethernet Security Manager (ESM) in FOXMAN-UN.
Open the Functional Unit View.

Select a SENC1 FU (running app-416_r16b03_01 software) and click on the “Deploy Soft-
ware” button.

Select the correct (r18a01) software from the drop-down list and mark the “Upload Software
to Unit” and “Activate Software” checkboxes.

Enter the Maintainer Password.

Confirm the software installation.

Wait until the units are getting manageable again; this will take at least around 15 minutes
since the units will reboot twice.

Once the FU upgrade is completed and the FU Communication Status will be “Manageable”,
select the FU from the Functional Unit View and click on the “Renew Credentials...” button.

10 Optional - Enter the Maintainer and Administrator passwords and click on the “OK” button.

This will store the passwords for possible future software updates and make the content of
the “Software Management” tab visible.

|I| Please note:
Steps 4 to 10 support batch operation given that the selected FUs have identical

password. You can select several FUs at the same time and run steps 4 to 10 on
all FUs in parallel.
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|I| Please note:

In step 5 you can check “Upload Software to Unit” box without checking the “Acti-
vate Software” box. In networks with multiple SENC1 units it is recommended to
first perform batch “Upload Software to Unit” on all FUs to be upgraded. Once the
upload is successfully completed you can perform a batch “Activate Software” on
all FUs to be upgraded. This can considerably reduce the upgrade time for all FUs.
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5 Foreign Object (FO) Upgrade to R18

5.1 Introduction

For the upgrade of NEs of type “Foreign Object” (FO) from an R16B or R17A installation to R18,
no special precautions need to be taken, provided the upgrade to R16B or R17A had been exe-
cuted in accordance with the respective application note [1TMRC000131] Application Note “FO
Migration Step by Step”.
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6 Annex

6.1 Document History

Table 4: Document history

Document ID FOXMAN-UN/ Rev. Date Changes since previous version
FOX61x
Release

1KHW028779 R18 A Oct 2025 First version for system release R18.

6.2 Technical Support

Please refer to the Hitachi Energy Collaborative Operations Portal COP, https://cop.hitachie-
nergy.com, for support contact information. Note that a valid registration is required to access

the COP.

6.3 References
[1KHW028777] Release Note “FOX61x R18”
[1TKHW002497] Operating Instruction “Precautions and safety”
[1KHW002466] User Manual “FOXCST” (FOX61x R18)
[1KHW028522] User Manual “Management Communication” (FOX61x R18)
[1KHW029028] User Manual “SENC1-4, SENC1F4, SENC1-8, SENC1F8”
[1KHW002499] Release Note “FOXMAN-UN R18”
[1KHW002414] User Manual “FOXMAN-UN under Linux”

[1TKHW029183-FR17A] Application Note “Upgrade ERPS from R1D to R17A”
[TMRCO000131] Application Note “FO Migration Step by Step”

[TKHW029171] Application Note “Access Control Lists (ACL)"
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Hitachi Energy Ltd
Bruggerstrasse 72
5400 Baden - Switzerland

Phone: please refer to https://www.hitachienergy.com/contact-us/Customer-Connect-Center
(Customer Connect Center)
Email: communication.networks@hitachienergy.com

www.hitachienergy.com/communication-networks
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